
 
 
 
 
 

 
 

FILE MANAGEMENT 

Introduction 
This document covers the basics of storing, filing and locating files on your computer. 
The instructions assume you are using Birkbeck’s computers, but the techniques 
contained herein are applicable more widely. 
 

Prerequisites 
The exercises below assume that you are familiar with the use of a computer keyboard 
and mouse. 
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About this Document 

Words in bold Will need to be typed or chosen from a menu 
or window 

Small capitals – e.g. ALT Indicate keys that you press 

Press KEY1 + KEY2 Press both keys together 

Press KEY1, KEY2 Press each key consecutively 

• Bulleted lists Are guidelines on how to perform a task 

Choose Insert - Picture Show menu commands – in this case, choose the option 
Picture from the Insert menu at the top of the screen 

 
This document is available from ITS reception, room 151 Malet Street or from the College 
intranet at www.bbk.ac.uk/its/docs/.  Large print copies are available on request 
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1. Windows Explorer 
Objectives To use the windows explorer window 

Method Use different features of the window 
Comments The Windows Explorer window appears in several guises – double-clicking on 

a link to My Documents or My Computer brings up an explorer window 

1.1  Windows Explorer 
Windows Explorer is a part of Windows and allows you to find, open, copy and 
move your files around. It comes in a variety of guises – if you open a link to My 
Documents or My Computer, those are also Explorer windows. 
 
There are several ways to open Windows Explorer. 
 

• Click on the Start button and see if Windows Explorer is available from 
that list of programmes – if so, click on it to open it 

• If it is not, hold down the  key and then press E once – that is the 
shortcut to open Windows Explorer 

 
Note the layout 
 

 

Here, My Computer is selected, 
so all the available disk drives 
are shown on the right 

Disk drives and 
folders are shown 
on the left 

The contents of the currently 
selected folder or disk are shown 
on the right 

 

1.2  My Computer - different drives 
What do we mean by disk drives? A drive is any kind of storage device attached to 
your computer.  The most common are 
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• USB (or “pen”) drive 
• Hard drive 
• Floppy disk drive 

 
In addition, in College you will have various networked drives – these are hard 
disks on which you have some space, connected to your computer via the 
network.  Your My Documents folder is on a networked drive. 
 
Each drive is given a letter –  
 

A: is the floppy disk drive 
C: is the hard disk within the computer 
E:, F: and/or G: are usually removable disks such as USB sticks 
Later letters are network drives 

1.3  Using Windows Explorer 
The contents of whatever drive you click on on the left-hand side will appear in 
the right-hand window. 
 

• Click on yourusername on ‘filer1.birkbeck.ac.uk’ (N:)  
 
You will see a list of folders on the right – note that the “My Documents” folder is 
one of them 
 

• On the right-hand side, double-click on the My Documents folder 
 
You will see a list of files and folders.  Folders are marked with a yellow icon, files 
will have different icons depending on which programme created them (Word, 
Excel, etc). 

1.4  The My Documents or My Computer window 
These two windows are also versions of Windows Explorer, although they appear 
slightly differently to the above example. 
 

• Close the Windows Explorer window using the x at the top right 
• If you have one, double-click the My Computer icon on the desktop 
• If not, or if you prefer, click on Start and then on My Documents, as 

shown 
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As you can see, the right-hand window still shows a list of files and folders.  
However, the left-hand side does not show a list of drives. The other places links 
are useful; 
 

 
• The second icon will be either My Computer, as above, or My Documents, 

depending on which icon you clicked to open the window originally. Click 
on that icon 

 
It is possible to make the left-hand side show a list of file locations, as before. At 
the top of the window, find the Folders button. 
 

• Click on the Folders button 
 

 
 

• That icon is a toggle – click it once to see the list of folders on the left-hand 
side, click it again to hide them 
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2. Files and Folders 
Objectives To look at how files are stored on a computer 

Method Look at file names within Windows Explorer 
Comments The extension is not always visible, but tells the PC which programme 

created a file. 

2.1  Folders 
Storage space on a computer is like a large filing cabinet – and therefore the better 
organised that space is, the easier it will be for you to find things later. 
 
Some folders are shown below 

 

2.2  Extensions 
All files have a three-letter extension, though it is often hidden from view. Some 
examples; 
 
Mywordfile.doc is a Word document (.doc) 
Accounts.xls  is an Excel spreadsheet (.xls) 
River.jpg  is a picture (.jpg) 
 
It is possible for the extension to be four letters; jpeg pictures, html files and mpeg 
videos have two possible extensions 

jpg  or  jpeg 
htm  or  html 
mpg  or  mpeg 

2.3  File types 
If you can see a particular programme’s icon then the extension is attached to that 
file, even if you cannot see it. 
 
The screenshot below shows five files.  The extensions are hidden but each has a 
different icon – that is because the extensions exist, and the computer is 
interpreting them to show which programme created each file 
 
 

 
 
 
 

Word documents PowerPoint presentation 

Jpeg (Picture) Excel spreadsheet 
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2.4  File sizes 
There are various different ways to view the files within your folders. They may be 
accessed either by the View menu or by clicking the icon shown below. 
 

 
• Find that icon, click on it and choose Details 

 
The files within the directory you are now looking at are listed, along with useful 
information such as their size and the date they were last changed. 
 
You may click on any column heading to sort files by that information 
 

 
 

• Click on the Date Modified heading to sort files in ascending order 
• Click the same heading to sort them with the most recently modified files 

at the top of the list 
 
Use the View menu to explore the different views available. Change back to the 
Icons view when you are finished. 
 

2.5  Creating a Folder 
• Browse to your My Documents area 
• Choose File – New – Folder 
• The folder is created – you should now type in the name you want to give 

it, then press RETURN to confirm 

 
  
Note that you can create folders within folders.  When you create a new folder, 
make sure that the right-hand window of explorer is showing the place where you 
want the folder to be created. 
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3. Opening a programme using a file 
Objectives Use Windows Explorer to open a file and the programme that created it 

Method Double-click on any file to open it 
Comments So long as you can see an icon you should be able to open the right program 

3.1  Open a file 
Double-clicking on a file will make the computer try to open the programme used 
to create that file and open the file within it. 
 

• With Windows Explorer open, browse to OldApps1 on ‘Win2k… 
• Open the folder Samples 
• Open the folder Word 
• Double-click on the file bears 

 
Note: If you find double-clicking unreliable, you may instead click on a file to select 
it, then press RETURN on the keyboard to open it. 
 
Word will be started and the document bears opened within it. 

3.2  Choosing a different programme 
With some types of file, it is possible to use different programmes to see and edit 
their contents. For these files, you may not want the default programme to be 
opened every time you double-click on them. 
 

• Close Word using the x at the top-right 
• In Explorer, browse to the folder Photoshop, which is on 

OldApps1/Samples/ 
• This folder contains jpeg image files, which will normally be opened either 

in the Windows Picture and Fax viewer or image-editing software when 
double-clicked 

• Right-click on the file OFInndis and click on Open With 
• You will see a list of software that may be used to open image files. Click 

on Internet Explorer 
 

 
 

Note: The Choose Program option at the bottom of the list allows you to browse 
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for software installed on your computer that does not appear on the list 
 

• Close Internet Explorer 
• In Windows Explorer, right-click on any file again 
• Click on Open With and then Choose Program 

 
There are several options here; 

1. Browse allows you to find a programme on your computer and use 
that 

2. The tick box below the list instructs the computer to use whichever 
programme you select as the default for that kind of file 

3. Note that the full file name, including extension, is shown at the top 
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4. Filing 
Objectives To move files around the computer 

Method Drag files and copy/paste them 
Comments Dragging files can be fiddly in a single window 

4.1  Creating a new folder 
We have already looked at creating a new folder but will create another one. 
 

• Open a new Windows Explorer window using  + E 
• On the left-hand side, click on My Documents 
• Choose File – New – Folder 
• Name this new folder Test (type in the name and press return) 
 

4.2  Moving files 
Files may be moved from one folder to another by dragging and dropping 
 
Your Windows Explorer window should show the contents of the My Documents 
folder 
 

• On the right-hand side, click and drag any file into the new Test folder 
 
The file is moved into the folder 
 
It is also possible to drag files from the right-hand side to the list of folders on the 
left, and even from one Windows Explorer window to another if you have more 
than one arranged so you can see them both. 
 

• Make sure the left-hand window is showing the My Documents folder and 
its contents 

• The right-hand window displays whatever is selected on the left – click on 
Test on the left-hand side 

• Click on the file that you just moved into that folder and drag it over to My 
Documents on the left.  When you move the file over My Documents, the 
label will turn blue – release the mouse button and the file is moved back 
where it came from 

 

4.3  Copying files from other drives 
If you drag files from other drives, they will be copied to the destination you select 
 

• On the left hand side, click on the minus symbol next to My Documents to 
hide the list of folders 

• Click on OldApps1 on ‘Win2k… to browse its contents 
• Open the folder Samples  
• Open the folder Photoshop 
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• On the left, use the scrollbar to scroll up until you can see My Documents, 
but do not click on it 

• Click and drag the file frog to the My Documents folder 
• Note the + that appears next to the file – that indicates that it is only being 

copied 
 
Should you want to move a file from one drive to another, you should hold down 
the SHIFT key to override the copy function. 

4.4  Using copy and paste 
Dragging and dropping files can be fiddly when there are many folders and/or 
drives available on a computer.  You may instead use the copy and paste functions, 
just as you would with text in a word processor. 
 

• If you have browsed elsewhere, return to OldApps1/Samples/Photoshop 
• Click on the file redeye 
• Choose Edit – Copy 
• On the left, scroll up to the My Documents folder if you cannot see it 
• Click on My Documents and open the Test folder 
• Choose Edit – Paste 

 
You may also right-click to use the copy/paste functions – note that cut allows you 
to move, rather than just copy, a file. 

4.5  Using send to 
The ‘send to’ function allows you to quickly send files to a limited selection of 
places. Different applications may add themselves to the list here, and USB sticks 
should appear in the list when they are connected to the computer. 
 

• Browse to OldApps1/Samples/Photoshop 
• Right-click on any file 
• Click on Send To 

 
Note the options presented – the most useful are My Documents and (not shown) 
a USB stick, which would appear at the end of the list, usually as drive (E:) or (F:) 
 

 
 

If you want to send several files to someone via email you may find it easier and 
quicker to do so using a zip file, which is a compressed group of files – it keeps 
them all together and is a smaller file than would otherwise be transmitted.  Select 
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the files by clicking on them whilst holding down the CTRL key, right-click, choose 
Send To and then choose Compressed (zipped) folder.  If a popup appears, click 
Yes.  The zip will be created and given the name of the first file selected – it will 
have a different extension (.zip) and therefore icon.  In the screenshot below, the 
lower file is the zip file. 
 

 

4.6  Selecting multiple files 
To select several files at one time you may either 
 

Hold down the SHIFT key to select files in a block 
Hold down the CTRL key to select or deselect individual files that are not 
next to one another 
 

The files selected may then be copied or moved using one of the techniques above 
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5. Finding files 
Objectives To search for files 

Method Use the search function to find files 
Comments Different search functions are available in different programmes – an 

application such as Word may have more thorough, if slower, search 
functions than explorer offers 

5.1  Searching for files 
Windows Explorer allows you to search for files in a variety of ways. 
 

• On the left, click on My Documents 
• Click on the Search button on the toolbar 

 

 

The keyboard 
shortcut for 
search is CTRL + F 

 
Windows Explorer will search whatever you have selected – in this case, the My 
Documents folder and any other folders contained within it 
 

• Type Test into the search box and press RETURN 
 

 
 
Try using some of the Search Options at the bottom – tick a box for further 
options. 
 
Note that the * may be used as a wildcard, so searching for an* will find all files 
that begin with the letters an, *.doc will find all Word documents and so on. 

Change the location to 
be searched here – 
search “My Computer” 
to search all drives and 
folders available.  
Beware – at Birkbeck 
that will include 
networked drives 
which have communal 
files on, so results may 
be extensive 

For a more 
thorough, if slower, 
search, you may type 
words in here to 
search the contents 
of files 
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6. File backups 
Objectives To search for files 

Method Use the Properties window 
Comments If you lose or overwrite a file, you may be able to retrieve an old version 

using the versions tab within that folder’s properties 

6.1  Previous Versions 
One of the major advantages of saving work on the College’s computers is that it 
is backed up.  Should you lose  
 

• In Windows Explorer, right-click on the My Documents folder 
• Choose Properties 
• Click on Previous Versions 

 
Note the list of dates and times available – to restore an old version of the folder, 
you would select a previous date and then click restore at the bottom of the 
screen – there is no need to do so now. 
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